
Formation QGIS 3.x

Journée 4 – 03 décembre



Journée 4

• Attributs et Formulaires

• Import Photos

• Impression / Export photo

• Contrôleur temporel
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Attributs et 
Formulaires

• Modes d’affichage

• Accès aux attributs : 
identifier ou sélectionner

• Identifier par clic

• Sélectionner
– Dans zone

– Par requête

• Améliorer l’affichage en 
mode formulaire

• Attributs géographiques
– Lesquels ?

– Automatiser 
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Les données attributaires
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Les options d’affichage des tables d’attributs

• menu Préférences > Options > Sources de données

• menu Projet > Propriétés > Sources de données



Les données attributaires
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Identifiable : les couches qui répondront à l’outil « Identifier les entités » 

Recherchable : les couches qui répondront à l’outil « Locator » 

Requis : les couches qui doivent faire partir du projet

Lecture seule : les couches qui ne pourront pas être modifiées

Privée : les couches « fond de plan » qui ne seront pas affichées dans l’explorateur



Les données attributaires
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Les options d’affichage des tables d’attributs



Les données attributaires
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Mode formulaire intégré

Mode Formulaire

Mode formulaire



Les données attributaires
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Mode tabulaire intégré

Tri possible

Mode Tabulaire / Tableau



Les données attributaires
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Les préférences et options

• Propriété « Couche » > Info-bulle > « nom d’un attribut »

• Propriété « Couche » > Etiquette > « nom d’un attribut »

Configuration label / étiquette



Les données attributaires
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Etiquette

Infobulle

Infobulle <> Etiquette
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Nom de 
l’attribut utilisé 

comme clé

Affichage des clés en mode Formulaire

Les données attributaires



La barre des Attributs
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Identifier les objets

Calculatrice de champs

Actions (attribut utilisé comme paramètre)

Résumé statistique

Ouvrir la table d’attributs (de la couche courante)

Mesurer (distances, superficies, angles)

Activer info-bulle (au passage de la souris)

QGIS 3.14



La barre des Attributs
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Identifier les attributs

• QGIS propose plusieurs façons d’identifier les entités avec 
l’outil         Identifier les entités. 



Identifier les entités
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En mode tableau, les options suivantes sont disponibles pour 
simplifier l’affichage et forcer le mode formulaire si une seule 
entité est identifiée.



La barre des Attributs
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Ouvrir la table d’attributs

• Affiche dans une fenêtre indépendante, sous forme d’un 
tableau, les attributs de la couche active.

– Si certaines entités de cette couche sont dans le panier de la 
sélection, ils sont mis en évidence dans le tableau.

– Plusieurs tables d’attributs peuvent être ouvertes simultanément. 

• Vous pouvez ouvrir la table d'attributs en cliquant avec le 
bouton droit sur la couche dans le panneau des couches et 
en sélectionnant "Ouvrir la table d'attributs", ou en 
utilisant le bouton spécifique dans la barre d'outils.



La barre des Attributs
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Ouvrir la table d’attributs

4 fonctionnalités :

Afficher toutes les entités

Afficher les entités sélectionnées

Afficher les entités visibles sur la carte

Afficher les entités modifiées et nouvelles



La barre de Sélection
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Sélection graphique des entités par « clic » ou rectangle 

Sélection graphique des entités avec un polygone

Sélection graphique des entités à main levée

Sélection graphique des entités selon un rayon

Sélection des entités par valeur

Sélection des entités à l’aide d’une expression

Sélection de toutes les entités

Inverser la sélection

Désélection de toutes les entités sélectionnées

Désélection des entités sélectionnées dans la couche courante
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Améliorer l’affichage des attributs
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L’affichage des attributs d’une commune est très « technique »

• Plusieurs options d’amélioration :
• Supprimer les champs inutiles

• Masquer un champ (trop technique, confidentiel …) 

• Renommer les libellés

• Ajouter des nouveaux champs

• Deux onglets des
propriétés de la couche :
• Champs

• Formulaire d’attributs



Améliorer l’affichage des attributs
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Couche « Communes » > onglet « Champs »

1 : Identifiant technique de la colonne
2 : Nom technique de la colonne
3 : Alias (du Nom) : à définir via l’onglet « Formulaire d’attributs » 
4 : Type de l’attribut au sens QGIS
5 : Type de l’attribut : entier, réel simple précision, réel double précision, texte, date
6 : Nombre total de caractères du champ
7 : Nombre de décimales pour un réel.
8 : Commentaire interne, non visible dans la table des attributs
9 : Réservé à la création d’un serveur WMS ou WFS

[2][1] [3] [4] [5] [6] [7] [8] [9]



Améliorer l’affichage des attributs
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Général / Type outil
• Accéder à l’onglet « Formulaire » 

• L’onglet « Formulaire d’attributs » vous aide à configurer le formulaire à 
afficher lors de la création de nouvelles entités ou de l’interrogation 
d’une fonctionnalité existante.

– Alias : un nom lisible par l’homme à utiliser pour les champs

– Commentaire: affiche le commentaire du champ comme indiqué dans l’onglet 
Champs, en lecture seule. Ces informations sont affichées sous forme d’infobulle lors 
du survol de l’étiquette de champ dans un formulaire d’entité.

– Editable: décochez cette option pour définir le champ en lecture seule (non 
modifiable manuellement) même lorsque la couche est en mode édition. Notez que 
la vérification de ce paramètre ne remplace aucune limitation de modification du 
fournisseur.

– Etiquette en haut : place le nom du champ au-dessus ou à côté du widget dans le 
formulaire d’entité.



Améliorer l’affichage des attributs
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• Onglet « Champs » → Supprimer un champ

• Passer la couche en mode Edition

• Sélectionner un ou plusieurs champs

• Les supprimer

• Sauver les modifications

• Annuler les modifications via propriétés de la couche en 
cours de modification :  

Editions en cours > fonctions d’annulation 



Supprimer des attributs !
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Passer en mode édition Solution radicale !



Améliorer l’affichage des attributs
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• Onglet « Formulaire d’attributs » → masquer un 
champ

• Sélectionner le champ à masquer

• Type d’outil > Caché

• Onglet « Formulaire d’attributs » → renommer un 
champ

• Sélectionner le champ à renommer

• Général > Alias (définir l’alias)

La mise en forme Formulaire n’est pas appliquée en mode Tabulaire



Calcul  d’Attributs géométriques

• Récupérer les valeurs d’attributs géométriques
– Superficie : $area 

– Longueur : $length

– Périmètre : $perimeter 

– Coordonnée X : x(@geometry)
• x(transform($geometry, 'EPSG:source', 'EPSG:cible'))

• x(transform($geometry, 'EPSG:3812', 'EPSG:313170’)) : L2008 → L72

– Coordonnée Y : y(@geometry)
• y(transform($geometry, 'EPSG: source', 'EPSG: cible'))

– Coordonnée Z : Séance 4

• Arrondir les valeurs (2 décimales)

 round($Fonction,2)
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Codes INS Belge

Formation QGIS – © JM Michalowski  - IFAPME 2024 25

• Le code INS est un code numérique, élaboré par Statbel, 
l’office belge de Statistique, attribué à chaque entité 
administrative afin de faciliter le référencement géographique 
des statistiques produites.

• Le code INS est une chaîne de cinq caractères :

• Le premier indique le numéro de la province.

• Le deuxième mentionne le numéro de l'arrondissement administratif.

• Les trois derniers définissent le code unique de la commune dans 
l'arrondissement.

• Découpage géographique administratif belge

https://statbel.fgov.be/fr/propos-de-statbel/methodologie/classifications/geographie


Lier un tableur

STATBEL 

• Statistiques belges → Tableau de statistiques agricoles 2023

• Informations par communes via le code communal INS

• Couche des communes : AdMuKey == code INS communal

• Insertion du tableau dans la BD
– Nettoyer le fichier pour ne conserver qu’un tableau avec entêtes

– Lien via extension « Ajouter Feuille de calcul … »

– Export du tableur lié vers le GPKG de la base de données

– Suppression du lien vers le tableur Excel
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Lier un tableur
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Attention au format des données à importer 



Lier un tableur
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Lier un tableur
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Lier un tableur

Créer la jointure avec la couche des communes

• Couche « Limites communales » > Propriétés > Jointure

• Etape 1 : joindre le tableau STATBEL à cette couche, via un 
champ commun

30Formation QGIS – © JM Michalowski  - IFAPME 2024



Lier un tableur

• Etape 2 : spécifier les champs du tableur à lier

• Etape 3 : personnaliser le préfixe du nom du champ
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Lier un tableur

Résultat final

32Formation QGIS – © JM Michalowski  - IFAPME 2024



Lier un tableur

Résultat final
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Lier un tableur

Résultat final
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Améliorer affichage attributs

Formation QGIS – © JM Michalowski  - IFAPME 2024 35

Deux modes opératoires « Formulaire d’attributs » :

1. Mode « Génération automatique » (options réduites)

2. Mode par « Glisser / déposer » (options avancées)

Les deux modes permettent de :
• Masquer des champs

• Masquer des étiquettes, définir leur couleur / police 

• Retirer des champs du formulaire

• Définir des alias

• Définir des listes de valeurs permises

• Définir des contraintes …



Améliorer affichage attributs
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« Glisser / déposer » : plus de possibilités

• Interface plus « efficace »

• Changer l’ordre des champs

• Ajouter des « Widgets » (gadgets)

• Une contrainte majeure : cliquer sur le bouton [Appliquer] 
après chaque modification

En personnalisant les formulaires, vous 
pouvez organiser et présenter les 
informations de manière claire et concise, 
rendant la saisie des données plus 
intuitive.



EXERCICE 1

Modifier les champs de la couche “Limites
communales” via la propriété “Formulaire d’attributs”
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Améliorer l’affichage des attributs
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Conception par génération automatique



Améliorer l’affichage des attributs
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Conception par glisser / déposer



Améliorer l’affichage des attributs
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Retirer des champs du formulaire



Améliorer l’affichage des attributs
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H010000 : Nombre d'exploitations
C000001 : Superficie agricole utilisée
C100000 : Superficie de terre arable

Définir un alias



Améliorer l’affichage des attributs
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Masquer l’étiquette du champ « Commune »



Améliorer l’affichage des attributs

Les « Widgets »

• Insérer une ligne horizontale 

• Insérer un texte simple (commentaire, note …)

• Insérer le contenu d’un champ, mais en imposant un 
formatage

• Insérer une photo (formation avancée : HTML + javascript)

• Personnaliser les formulaires (langage QML)
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Améliorer l’affichage des attributs
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« Spacer Widget » → Insérer une ligne



Améliorer l’affichage des attributs
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« Spacer Text » → Insérer un commentaire



Améliorer l’affichage des attributs
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« Spacer Text » → Imposer un formatage à la valeur d’un champ

round("Shape_Area" /10000,2)  || ' Ha'



Améliorer l’affichage des attributs
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Résultat attendu



Formulaire – lien vers la photo

Couche « Mairies » > Propriétés > Formulaire
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Formulaire – lien vers la photo
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[Appliquer] – [OK]



Formulaire – lien vers la photo
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Améliorer l’affichage des attributs
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« Widget HTML» → insérer une photo (formation avancée)



Import 
Photos

• Installer le plug-in

• Recommandations

• Importer des photos

• Ajouter des photos
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Import Photos

Le module « ImportPhotos » pour QGIS est un plugin 
gratuit et open-source qui permet d'importer des 
photos géo-referencées (jpg ou jpeg) dans un projet 
QGIS.

Une couche de points (SCR : WGS84) sera créée avec 
les métadonnées de la photo (la date et l'heure de prise, 

l'altitude, la longitude, le modèle d’appareil photo, …), le nom de la 
photo et son chemin d’accès.
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Import Photos - installation

• menu > Extensions > Toutes

• Rechercher : mot-clé « Photos » 

• Installer « Import Photos » 
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Import Photos

• Les photos doivent être géolocalisées, c’est-à-dire avoir été 
prises avec le GPS activé;

• Elles seront stockées dans un répertoire dont le chemin 
d’accès ne comporte pas d’espace; les sous-répertoires ne 
sont pas pris en compte;

• La couche de points (SCR : WGS 84) créée sera stockée 
dans un géopackage (.gpkg) dédicacé; 

• Un jeu de photos géolocalisées libres de droit peut être 
téléchargé à partir de cette adresse : 
https://sigefor.be/Database/Noeuds.zip 
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https://sigefor.be/Database/Noeuds.zip


Import Photos – Nœuds vélo
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Exécuter l’extension « ImportPhotos »
Définir le répertoire « Input » où sont localisées les photos
Définir la localisation et le nom du géopackage de stockage

Pour info



Import Photos – Nœuds vélo
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Pour info



Import Photos – Nœuds vélo
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Pour info



EXERCICE 2

Importer des photos
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Import Photos - Arbres

• Dossier photos : D:\Cartographie\Data\Photos\Arbustum 

• Nom du GPKG à créer : D:\<…>\Data\Jour4\ 
Photos_Arbustum.gpkg

• Sélectionner le groupe « Environnement »

1. Exécuter Import Photos

60Formation QGIS – © JM Michalowski  - IFAPME 2024

• 69 photos ajoutées
• 13 photos refusées car non géolocalisées



Import Photos- Arbres

2. Copier les 5 images du dossier D:/<…>/data/Photos/AddOn 
vers D:/<…>/data/Photos/ Arbustum

3. Exécuter la mise à jour de ImportPhotos

4. Choisir la couche « Photos_arbustum » 
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• 5 nouvelles photos ajoutées
• 13 photos refusées car non géolocalisées



Impressions

• Décorations de la carte

• Mises en page

– Eléments de base
• Carte

• Echelle Nord

• Barre d’échelle

• Légende

• Simplifier la légende

– Autres éléments

– Imprimer
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Décorations de la carte
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menu Vue → Décorations

• Grille == graticulage 

• Barre échelle

• Image

• Flèche Nord

• Etiquette de titre

• Etiquette de ©

• (Emprises des mises en page)



Décorations de la carte : Grille
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Décorations de la carte : barre échelle
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Décoration de la carte : Flèche Nord
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Décoration de la carte : Titre
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Décoration de la carte : ©
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Décoration de la carte : emprise mises en page
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Mise en page

La mise en page doit suivre une construction rigoureuse basée 
sur les principes de Sélection (choix de format, données à 
afficher...), schématisation (que faire apparaitre, comment 
mettre en avant le message, charte graphique, …), 
harmonisation (cela doit être agréable à l’œil ).
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Mise en page

La mise en page de carte fournit des fonctionnalités de mise en 
page et d’impression. Elle vous permet d’ajouter des éléments tels 
que :

– le canevas de carte (un ou plusieurs), 
– des zones de textes (titres, ©, …), 
– des images (logos …), 
– des légendes, 
– des échelles graphiques, 
– des formes de base, 
– des flèches, 
– des tables attributaires,
– des cadres où insérer du code HTML (→ accès à une ULR par exemple)

Tous les outils du composeur de cartes sont disponibles dans les 
menus et les barres d’outils. Ces barres peuvent être affichées ou 
masquées en faisant un clic droit dessus.
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Mise en page

Points d’attention :

• Avant de démarrer la mise en page, vous devez charger des 
couches raster et/ou vecteurs dans la fenêtre principale de 
QGIS et adapter leurs propriétés (échelle de visibilité, ordre 
d’affichage, taille et couleur des symboles et étiquettes …) 
pour qu’elles vous conviennent. 

• Quand tout est rendu et symbolisé comme souhaité, vous 
pouvez commencer la mise en page.
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Mise en page

Points d’attention :

• Si l’affichage est trop lent dans la mise en page, décocher les 
couches RASTER, WMS …

• Pour un usage public, si vous imprimer le fond de carte de 
l’IGN, n’oubliez pas d’ajouter dans une zone de texte, la 
mention suivante, en l’adaptant avec votre numéro de 
convention (http://cartoweb.be) :
« Extraits de CartoWeb.be avec l'autorisation de L'institut géographique 

national <<VotreConvention>>- www.ign.be » 
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Le Gestionnaire de mises en page
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Afficher la sélection : vous pouvez sélectionner 
plusieurs rapports et / ou imprimer des mises en 
page et les ouvrir en un seul clic. Double-cliquez 
sur un nom pour l’ouvrir ;
Dupliquer la mise en page ou le rapport 
sélectionné (disponible uniquement si un élément 
est sélectionné) : cela ouvre une nouvelle fenêtre 
utilisant l’élément sélectionné comme modèle. Le 
gestionnaire vous demandera de choisir un 
nouveau titre pour la nouvelle mise en page ;
Renommer la mise en page ou le rapport 
(disponible uniquement si un élément est 
sélectionné) : le gestionnaire vous demandera de 
choisir un nouveau titre pour la mise en page ;
Supprimer la mise en page : la ou les mises en 
page seront supprimées du projet.



Le Gestionnaire de mises en page
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Création de nouvelles mises en page 

• A partir de modèles stockés sous :
• Le répertoire défini dans le profil de l’utilisateur
• Dans le répertoire QGIS des modèles
• Dans tout autre répertoire défini via 

Préférences ‣ Options ‣ Mise en page



Le Gestionnaire de mises en page

Les onglets

• Le panneau Mise en page vous permet de définir les 
paramètres généraux à appliquer à la mise en page lors de 
l’exportation ou du travail ;

• Le panneau Éléments fournit la liste de tous les objets de la 
mise en page ajoutés au canevas et des façons 
d’interagir(verrouillage) globalement avec eux.

• Le panneau Historique affiche l’historique de toutes les 
modifications appliquées à la mise en page. D’un simple 
clic de souris, il est possible d’annuler et de refaire les 
étapes de mise en page jusqu’à un certain état ;
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Le Gestionnaire de mises en page

Les onglets

• Le panneau Propriétés de l’objet affiche les propriétés 
pour l’objet sélectionné sur la mise en page;

• Le panneau Guides permet de définir des guides 
d’accrochage horizontaux et verticaux (qui forment 
une grille) afin de positionner très précisément les 
objets posés sur le canevas de la mise en page, et de 
définir les marges physiques de votre imprimante.
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Créer une nouvelle mise en page

Deux méthodes pour créer une nouvelle mise en 
page

• Créer directement :                                  ou CTRL-P

• Accéder au Gestionnaire de mise en page > [Créer]
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Valider [OK]



Créer une nouvelle mise en page

Ouvrir le projet « D:/…/Data/Jour4/Jour4-01 »
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Ctrl-P



Créer une nouvelle mise en page
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Créer une nouvelle mise en page

Les guides
• Permettent de définir la zone 

réellement imprimable, en 
tenant compte des marges 
physiques de l’imprimante 
(notion de marges 
d’impression)
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Créer une nouvelle mise en page
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Bordure de 5 mm tout autour de la page



Les objets élémentaires

4 objets élémentaires pour une impression conforme

• La carte
– Zone rectangulaire dans laquelle s’affiche la carte QGIS

• L’échelle
– Barre d’échelle ou échelle numérique

• La flèche Nord
– Insertion d’une image représentant une flèche Nord. Rotation Ok

• La légende
– Insertion d’un cartouche de légende, peut être complexe, envisager de le 

simplifier. Etape qui peut demander du temps

83Formation QGIS – © JM Michalowski  - IFAPME 2024



Les objets élémentaires : la carte
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Accrocher la carte sur les guides



Les objets élémentaires : la carte
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Cadrage courant dans la mise en page



Les objets élémentaires : la carte
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Propriétés principales

Echelle : Echelle de tracé de la mise en page
Rotation de la carte : avec suivi de la Flèche Nord 
SCR : Choix du SCR de tracé ;
   Dessiner les objets du canevas de carte : 
Afficher dans la mise en page les annotations de 
la carte principale.

Par défaut, l’apparence de l’objet carte est synchronisée 
avec le rendu du canevas de la carte, ce qui signifie que 
le basculement de la visibilité des couches ou la 
modification de leur style dans le Panneau couches est 
automatiquement appliqué à l’objet Carte (de la mise 
en page). 

Verrouiller les couches (et les styles) permet de 
conserver le contenu cartographique de votre 
mise en page.



Les objets élémentaires : l’échelle

Les barres d’échelle fournissent une indication visuelle de la 
taille et de la distance entre les entités représentées sur la 
carte. 
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Les styles de barre d’échelle

Carte : carte à laquelle la barre d’échelle 
sera associée
Style : 8 styles de représentation de la 
barre d’échelle
choisir « Numérique » pour afficher une 
échelle numérique



Les objets élémentaires : l’échelle
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Unités de la barre d’échelle : sélectionner les unités à 
utiliser. 
Multiplicateur des unités de l’étiquette : indique le nombre 
d’unités de la barre d’échelle par unités étiquetées.
        « mètres » -> multiplicateur 1000 -> « kilomètres ».
Etiquette pour les unités : permet de définir le texte à 
utiliser pour étiqueter les unités de la barre d’échelles.
Format de Nombre : Personnaliser les options de la légende 
numérique

Segments : Définir le nombre de segments à Gauche et à 
Droite du zéro de la barre d’échelle
Largeur fixe : largeur des segments fixes
Largeur ajustée au segment : à chaque fois que l’échelle 
de la carte est modifiée, la barre d’échelle est 
redimensionnée (et les étiquettes modifiées) pour 
s’adapter à l’intervalle.
Hauteur : hauteur des barres.

Gauche 0 et Droite 4 Gauche 2 et Droite 4



Les objets élémentaires : l’échelle
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Les objets élémentaires : la flèche Nord
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• La Flèche Nord est liée à une carte (carte de référence par 
défaut)

• Un fichier SVG est associé automatiquement à la création de 
la flèche Nord; il provient de la bibliothèque SVG de QGIS

Mode de redimensionnement : définir comment l’image 
est affichée lorsque le cadre de l’objet Image est modifié.
• Zoom
• Etirer
• Découper
• Zoom et redimensionner le cadre
• Redimensionner le cadre à la taille de l’image
Position : sélectionner la position de l’image à l’intérieur 
du cadre de l’objet Image



Les objets élémentaires : la flèche Nord
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Les objets élémentaires : la légende

La Légende à imprimer

L’objet le plus complexe à paramétrer 

Trouver le bon équilibre entre la visibilité  de la légende (à l’impression !) et le 
nombre d’éléments présents dans la  légende.

Comment faire ?

• Ne pas multiplier les thématiques à imprimer sur une seule carte
• Choisir des symbologies nettes et bien distinctes à l’impression

– Éviter par exemple, 10 représentations dans une même gamme de 
couleurs

• Prendre le temps de tester à l’impression (pdf + papier) les symbologies
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Les objets élémentaires : la légende
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Les objets élémentaires : la légende
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Eléments de la légende
La fenêtre des éléments de légende répertorie tous les 
éléments de la légende et vous permet de changer 
l’ordre des éléments, de grouper les couches, de 
supprimer ou de restaurer des éléments de la liste, de 
modifier les noms des couches et d’ajouter un filtre.

Propriétés principales
Titre : Modifier le titre de la légende
Carte : Choisir la carte qui sera décrite par la légende (utile en 
cas de multi-cartes)
Activer le retour à la ligne après : Définir un caractère qui 
permet l’insertion des retours à la ligne
Disposition : Définir la position des symboles et du texte dans la 
légende (gauche ou droite)
     Ajuster au contenu : 
1. Contrôle si la légende doit être redimensionnée 

automatiquement pour s’ajuster au contenu ou pas.
2. Si elle est décochée, la légende ne sera pas redimensionnée 

et gardera la taille définie par l’utilisateur. Le contenu qui 
dépasse sera coupé.



Les objets élémentaires : la légende
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Mise à jour auto
La légende sera automatiquement mise à jour si  
Mise à jour auto est cochée. Si cette option n’est 
pas cochée, cela vous donnera plus de contrôle sur 
les éléments de la légende. Tous les boutons situés 
sous la liste des éléments de la légende seront 
activés.
[Tout mettre à jour] : mise à jour de la légende 
après modification de la symbologie dans la carte
    Ne montrer que les entités à l’intérieur de la 
carte liée



Les objets élémentaires : la légende
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En décochant « Mise à jour auto » et en cochant « Ne montrer que les entités
liées à la carte, la légende s’allège considérablement



Les objets élémentaires : la légende
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Simplifier la légende à imprimer : retirer les couches inutiles



Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  masquer des titres



EXERCICE 3

Ajouter les éléments de base d’une mise en page

99Formation QGIS – © JM Michalowski  - IFAPME 2024



Mise en page
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Mise en page
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  ajouter des éléments de légende

• Revenir dans la fenêtre carto de QGIS

• Ouvrir le signet « Mairie de Grivegnée »

Revenir à la mise en page 



Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  ajouter des éléments de légende



Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  adapter les libellés



Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  agencement en colonnes



Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  agencement en colonnes



Les objets élémentaires : la légende

Formatage texte
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Autres options



Les objets élémentaires : la légende

Formatage texte
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Autres options



Autres objets de mise en page

L’objet IMAGE

• Insertion d’une image : fichier image ou fichier SVG → logos
– Taille et position / Rotation

– Dimensions

– Cadre et arrière-plan

L’objet FORME
• Insertion d’une forme vectorielle

– Rectangle – Ellipse – triangle 

– Taille et position / Rotation

L’objet SYMBOLE
• Insertion d’un symbole de la bibliothèque

– Taille et position / Rotation

– Arrière-plan
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Autres objets de mise en page



Autres objets de mise en page

L’objet Etiquette

• Les objets de type Étiquette vous permettent d’ajouter du 
texte à vos cartes et d’améliorer leur compréhension ; il 
peut s’agir du titre, de l’auteur, des sources des données ou 
tout autres informations … 
– Contenu de l’étiquette : texte ou HTML

– Police / Couleurs du texte

– Taille et position / Rotation

– Dimensions

– Cadre et arrière-plan
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Autres objets de mise en page - Etiquette



Autres objets de mise en page

La table Attributaire
• Toute couche du projet peut voir ses attributs affichés dans 

la mise en page. 
• Par défaut, un nouvel objet table d’attributs charge les 

premières lignes de la première couche (triée 
alphabétiquement), avec tous les champs. Vous pouvez 
cependant personnaliser le tableau grâce aux différentes 
propriétés, principales et d’affichage. 

Ajouter une page à la mise en page courante
• Insérer une table attributaire
• Insérer une autre carte
• Etc.
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Autres objets de mise en page – La table attributaire



Imprimer la mise en page
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Contrôleur 
temporel

• Définitions et usages

• Jeu de données

• Exporter les données

– Copies d’écran

– Atlas de plans

• Image animée
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Contrôleur temporel

Contrôleur temporel

• Le Contrôleur temporel est une interface qui vous permet de 
naviguer à travers les données temporelles (série 
temporelle) dans votre projet QGIS.

• Il peut être utilisé pour contrôler les couches ayant une 
dimension temporelle, vous permettant de visualiser les 
données à différents moments dans le temps. Par exemple :
– Il permet de définir l'intervalle de temps et d'animer les données 

temporelles.

– Il offre des contrôles de lecture, de pause, d'avance rapide, etc.
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Contrôleur temporel

Série temporelle
• La Série temporelle se réfère plus généralement à des 

données qui sont enregistrées à différents moments.

• Dans QGIS, cela signifie que vos couches peuvent avoir des 
attributs ou des géométries qui varient au fil du temps.

• Les séries temporelles sont utilisées pour analyser et 
visualiser les changements dans les données spatiales au 
cours du temps.
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Contrôleur temporel – jeu de données

Jeu de données

Constitué des couches suivantes :

• Limites des provinces et des communes (Cadastre BE)

• Observations de la Berce du Caucase en RW (Géoportail)

• Carrés d’observation IFBL de 4x4 km (Géoportail)

Il est mis en forme pour obtenir des champs DATE au format 
« Date » et pour associer à chaque carré IFBL, les observations 
de la Berce du Caucase, par année, via une relation 1- N.
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Contrôleur temporel - données
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Couche « Berce » [Points] Couche « Carré IFBL » [Polygones]



Contrôleur temporel – relation 1-N

118Formation QGIS – © JM Michalowski  - IFAPME 2024

Etapes :

1. Pour chaque point d’observation de la Berce, lui assigner le 
numéro de carré IFBL 

2. Créer une relation 1 – N

3. Pour chaque point d’observation de la Berce, calculer l’année 
de la première observation

4. Pour chaque carré d’observation, retrouver la date de la 
première observation et le nombre total d’observations

Formation avancée



Contrôleur temporel – relation 1-N

Relation 1 – N
– On parle de relation attributaire pour des liens de 1 à 

n. Les valeurs d’un champ dans la table attributaire 
d’une couche vectorielle correspondent à plusieurs 
valeurs d’un des champs du tableur à joindre.

– Exemples :
• Une école et ses populations scolaires annuelles;

• Une grille d’inventaire et des inventaires botaniques 
réguliers;

• Une terre cultivée et l’ensemble des travaux sur une période 
donnée.
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Formation avancée



Atlas cumulatif 2001-2020
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Formation avancée → Atlas de plan + contrôleur temporel



Contrôleur temporel - Configuration
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Le contrôleur temporel se configure à deux niveaux : 

• Dans les propriétés du projet
– Prend le pas sur la configuration au niveau de la couche si le 

contrôleur temporel est activé pour la couche

– Intéressant quand il s’agit de restreindre la plage temporelle si les 
données d’une des couches couvrent une trop longue période.

• Dans les propriétés des couches
– A partir des valeurs de dates d’un champ de type DATE

– Pas de filtre possible sur la plage temporelle



Configuration : projet
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Définition manuelle ou à partir de couches
qui ont une plage temporelle déjà définie



Configuration : couche
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Les différentes configurations de base
• Plage de temps fixe : toutes les entités sont rendues si le cadre temporel du 

canevas de la carte chevauche la plage de dates de début et de fin donnée;

• Champ unique avec date/heure : les entités sont rendues si la valeur de leur 
champ DATE se situe dans le cadre temporel du canevas de la carte. La durée d'un 
événement peut être définie.
– En cochant l' option Accumuler les entités au fil du temps, toutes les entités qui s’affichent pendant 

la plage temporelle de la carte continueront à être rendues. La durée de l'événement est donc 
ignorée.

• Champs séparés pour la date/heure de début et de fin : les entités sont rendues si 
la plage spécifiée par leurs valeurs de champ de début et de champ de fin 
chevauche le canevas temporel de la carte.

• Champs séparés pour le début et la durée de l'événement : les entités sont 
rendues si la plage définie par leurs valeurs de champ de début et de durée de 
l'événement chevauche le temps du canevas de la carte.



Configuration : couche
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Pour information



Configuration : couche

125Formation QGIS – © JM Michalowski  - IFAPME 2024

Pour information



Configuration : couche
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Pour information



EXERCICE 4

Configurer le contrôleur temporel de la couche “Berce”
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Configuration de la couche « Berce »
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Filtrer les données dont « Année > 0 »

Couche « Berce » > Filtrer



Configuration de la couche « Berce »

130Formation QGIS – © JM Michalowski  - IFAPME 2024

Couche « Berce » > Propriétés > Onglet Temporel



Série temporelle « Berce »
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Série temporelle « Berce »
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Navigation temporelle désactivée : toutes les données de la couche sont affichées



Série temporelle « Berce »
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Navigation à plage fixe : les données de la couche sont affichées selon la plage définie



Série temporelle « Berce »
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Navigation temporelle animée : animation des couches temporelles



Série temporelle « Berce »
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EXERCICE 5

Exporter toutes les vues, année par année
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Contrôleur temporel
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Navigation temporelle animée : paramètres d’animation des couches temporelles

Exporter l’animation sous formes d’images



Contrôleur temporel

Si vous souhaitez des 
images au format 
« 4/3 », vous pouvez 
redimensionner la  
fenêtre QGIS pour lui 
donner (+/-) ce ratio 
« 4/3 »
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Définir la proportion des images à exporter



Contrôleur temporel

Ajouter une Etiquette pour identifier l’année 
d’observation

menu > Vue > Décorations > Etiquette de titre 
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Contrôleur temporel

Utilisation de deux variables de la carte pour afficher 
la plage temporelle

• @map_start_time : moment où commence la plage temporelle affichée.

• @map_end_time : moment où se termine la plage temporelle affichée.

Formatage sous forme de DATE

• [%format_date(@map_start_time, 'yyyy’)%]

• [%format_date(@map_end_time, 'yyyy')%]
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Contrôleur temporel

Rendre le fond de l’étiquette transparent en 
définissant une couleur d’arrière-plan Opacité = 0 %
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Contrôleur temporel
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Couche « Berce » > Propriétés > Onglet Temporel



Série temporelle « Berce »
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Nom du Modèle

Exporter l’animation sous formes d’images

Dossier de 
sauvegarde



Contrôleur temporel
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Contrôleur temporel
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Créer une image animée (GIF) en compilant 
toutes les images générées → GIMP (Open 
Source)



Image animée
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Créer une animation GIF
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Les étapes

1. Fichier > Ouvrir la première image de l’animation

2. Fichier > Ouvrir en tant que calques les images suivantes

3. Filtre > Animation > Optimiser (pour GIF)

4. Fichier > Exporter sous …
– Saisir le nom du fichier à exporter, avec extension .GIF

Pour information



Créer une animation GIF
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Fichier > Ouvrir la première image de l’animation

Pour information



Créer une animation GIF
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Fichier > Ouvrir en tant que calques les images suivantes

Pour information



Créer une animation GIF
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L’ensemble des images est chargé

Pour information



Créer une animation GIF
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Filtre > Animation > Optimiser (pour GIF)

Pour information



Créer une animation GIF
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Fichier > Exporter sous …

Pour information



Créer une animation GIF
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Saisir le nom du fichier à exporter, avec extension .GIF

Cliquer sur [Exporter]

Pour information



Créer une animation GIF
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Définir les paramètres d’animation comme suit

Cliquer sur [Exporter]

Pour information
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